Using BrioQuery( 6.x

With the Oracle Data Warehouse (Dwh1)

Training Manual

This manual is designed as a step-by-step guide for classroom training as well as a useful reference. It introduces the major features of BrioQuery 6.x to users.

OBJECTIVES
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This manual is designed for those who need to query the Oracle Data Warehouse for financial information and create reports based on the information extracted. The lessons assume a familiarity with Windows basics, such as choosing menu items and using a mouse.

The lessons in this manual are illustrated with several screen captures to help illustrate the concepts. By the end of the lessons, users will be able to:

· Create queries using MetaModels

· Analyze data

· Create a variety of reports

· Manipulate pre-built queries and reports
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I. BRIOQUERY DOCUMENTS
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A BrioQuery document is your workspace for using Brio to obtain information from the Oracle Data Warehouse. BrioQuery documents can contain several Sections:

· The Query Section lets you create your request for information to the database. From the MetaModel tables you select the items or ‘fields’ that you need.

· The Results Section displays the results from processing the Query Section. With some formatting and presentation manipulation, the Results Section can deliver useful information. The Results are also used by the other BrioQuery sections.

· The Table Section displays your data in table format. You can add additional lines, such as totals, to have an overview of the subset of the Data Warehouse database.

· In the Pivot Section you can produce a report that resembles a spreadsheet or crosstab report. Pivot reports consist of side labels, top labels, and facts. Side and top labels have handles that can be pivoted to the top or side of the report.

· The Chart Section lets you create graphs and charts. It is recommended that if you wish to create charts you export your data to Excel and create them there.

· The Report Section is used to create presentation reports. It gives users the ability to create free-form report styles. Exclusive to the Report Section is the ability to include pivot reports, charts, and table reports.

Documentation provided by Brio Technology:

Brio Software provides manuals that we allowed to copy. The manual that covers the Query and Results Section is named “Getting Started with Brio Intelligence 6.6”. The manual that covers Tables, Pivot Tables, Charts and Reports is named “Data Analysis and Reporting with BrioQuery 6.5”. 
These manuals are available from RIS at the following website:

http://www.yale.edu/ris/sub_store_bookstore.html  Just go to the General Store. They are named Brio Manual I (11.50) and Brio Manual II (9.10).

II. BRIOQUERY BASICS
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A. Open BrioQuery 6.x
As with all production applications, BrioQuery 6.x should be opened using YAMS (Yale Administrative Menu System). Click on the Reporting folder in the top window. BrioQuery 6 will appear as one of the options in the bottom window. (See figure 1).
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Figure 1: YAMS

A dialog box with a warning will appear:
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Figure 2: Warning

This is just to warn users opening BrioQuery 5.x files that they may have a problem with converting them to version 6. 

Click on OK and the connection box on the next page will appear.

B. Connecting

In order to use the BrioQuery tool we must connect to a database through a connection file called an OCE. This new version of Brio asks for that connection up front or requires that you open an existing document. When you open BrioQuery for the first time the Connection Wizard dialog box is blank.
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Figure 3: Connection Wizard

As you access or create queries, the bottom pane will list those documents. The top pane will list your connection files as you use them and will automatically select your default OCE if you set one. Complete the following steps:

Figure 4: Select Connection
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1. For this first time click on the top Browse… button. Find the location of your OCE files. They should be in your C:\Brio\opencat folder.

2.  Select Dwh1.oce.

Figure 5: Logon Box
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3. The log on box for the OCE file appears. Put in the correct netID and password. The password is the same as the one you use for the Data Warehouse Portal.

The main BrioQuery window will appear (see next page). Before reviewing the screen, let’s set some defaults. 

C. Default Settings

· Go to Tools\Options\Program Options…

· Click on the File Location tab. There are 3 locations to be concerned with: Documents Directory, Connections Directory and Default Connection.

· With the new version you can now tell BrioQuery where to find your queries. Use the browse button next to the Documents Directory window to locate the folder where you keep your queries.

· Use the browse button next to the Connections Directory window to find the folder where you keep your OCEs.

· If you use the same OCE all the time, or the majority of the time, you can select that OCE as the default in the Default Connection window.

When you are done the Options dialog box should like the figure below.





Figure 6: Default File Locations
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Next go to the DataModel menu and select Data Model Options . . . On the General tab uncheck the Auto Join Tables option. The reason for this will be explained in the discussion of joins.

D. The BrioQuery Screen (Figure 7)
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Legend:

	1
	Remove Button
	17
	Section Title Bar

	2
	Format Painter Button
	18
	Request Line Button

	3
	Show Section/Catalog
	19
	Limit Line Button

	4
	Insert Section Button
	20
	Sort Button

	5
	Properties Button
	21
	Back Arrow

	6
	Limit Button
	22
	Forward Arrow

	7
	Sort Ascending Button
	23
	Catalog Pane

	8
	Sort Ascending Button
	24
	Tables

	9
	Grand Total
	25
	Request Line

	10
	Group Items
	26
	Sort Line

	11
	Process Button
	27
	Limit Line

	12
	Connections Manager
	28
	Table

	13
	Back Arrow
	29
	Fields

	14
	Forward Arrow
	30
	Content Pane

	15
	EIS Home Button
	31
	Status Bar

	16
	Help
	32
	Section Pane


1 – The Remove Button. What used to be a button that said Remove is now a black X.

2 –  The Format Painter Button. As of right now there is no information on how this works. One could assume that it functions like the format painter in Excel or Word. 

3 –  Show Section/Catalog. A toggle button that shows/hides the table catalog pane and the sections pane. 

4 –  Insert Section Button. Brio documents may contain multiple queries. Click on this button to quickly insert a new query. Using the drop down arrow you can also insert report sections.

5 –  Properties Button. Highlight a table title, a field in a table or a field on the Request or Limit Line then click on this button. A dialog box appears which allows you to view the relevant properties and in most cases you can make modifications to those properties.

11 – Process Button. Clicking on this button will process the current query. If you click on the drop down button gives you more choices if you have multiple queries in the document.

12 - Connections Manager. A neat tool! You can log on and off queries, modify your OCE or change your password.

17 – Section Title Bar. Notice that it contains buttons 18-20 which tells you how many items are on the Request, Limit and Sort Lines.

23 – Catalog Pane. Contains the Table catalog and 24 – the original tables.

32 – Section Pane. This is how you navigate between sections. No more tabs.
E. Open A MetaModel

Retrieving a MetaModel Template from the Library on NTserver

1. Select File>Open from the menu bar or click on the Open File icon on the standard toolbar.

Figure 8: File/Open
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At the top of the dialog box notice the words Look in: with a box to the right. It will be pointing to the last folder you were in or the default specified on your shortcut. Click on the down pointing arrow on the right of the box. (Figure 8)

3. Navigate down the list until you get to Library on ‘Ntserver” (L:).
4. Double click on the selection or select Open. The Open File box changes (See Figure 9).

Figure 9: Open the DataWhse Folder
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5. Open the Datawhse folder and the folder called The MetaModels. You should now find a MetaModel with the name Consolidated transactions current dimensions.BQY. 
Note: The MetaModel queries have been designed by the technical staff and are constructed to include the appropriate tables and joins with the objective of providing the user with the necessary information to construct useful queries. It is very important that you do not change any joins by deleting or adding them. It may make the query unusable.

The figure on the next page shows what your screen should look like once you have retrieved the basic MetaModel for transactions.

· Joins: In order to obtain all the information you need from the Data Warehouse, in most cases you must use more than one table. To do that, tables must be “joined”. This is a method of linking two or more tables so that you can extract all the data you need in one query and your reports will contain all the information that is required.

If two tables share a field in common, they may be joined and you may select fields from both tables for your query. You can include multiple tables as long as there is an identical field (fields that contain the same data not necessarily the same name) that you can join. By using the MetaModel the joins are already made for you and you can be sure that they are appropriate. Do not add or delete joins.
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Join line:
F. The Transactions MetaModel 
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Despite the number of tables this is not as complex as it looks. The tables are in Icon view. As long as they are minimized as an icon they do not participate in a query. This model is constructed this way so that you only open the tables that you need to use to extract the necessary information. The middle table, which is the center of all the joins, must be opened for the query to work.  

Figure 10: The Consolidated transactions current dimensions* MetaModel

*This current dimensions model provides current attributes for historical data.

MetaModel Rules

1. You must always limit the Fiscal Period even if you want all the fiscal periods in the Data Warehouse.

2. The middle table must always be used or the joins will be ineffective. Make a habit of limiting Fiscal Period in the middle table. 

3. If you are not using any data from a table, make sure it remains in ICON view. Your query will run faster.

4. Do not create your own joins or delete existing joins unless you have the technical expertise. Your query won’t work.
5. For more information regarding joins please refer to the BrioQuery manuals mentioned on page 4.
G. File Save
It is always a good practice to immediately perform a File/Save As operation and name your document. Use either the File menu or click on the diskette in the standard tool bar. Now that your default file location has been set, the Save box should open directly into that folder. The default name “Untitled” will appear in the File name: box. Give the file a name related to the query you are about to create.





Figure 11: File/Save As
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H. Table Basics

Double click on the Accounting Transactions table icon. The table changes to what is called Structure View. (See Figure 12) Now you are able to see the field names so that you can select the information you wish to retrieve from the database. 

Figure 12: Structure View
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Figure 13: Alphabetize Field Names
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To alphabetize field names:

· Double click anywhere on the Title Bar of the Accounting Transactions table. This will open a dialog box. (See Figure 13)

· Click on Sort (last button on left side) and OK. 

· To view the field content:

· Select Fiscal Period in the Accounting Transactions table.



· Right click and select Show Remarks. See Figure 14.
· You will then get the box in Figure 15. For illustrative purposes, there is a circle around the format for the field. If we are going to set a limit on Fiscal Period we must know the content of the field. The box also gives a description which further explains what is in the field. This function is part of the Data Dictionary. Data Dictionary classes are available for those who wish to become serious Brio users.
Figure 14



Figure 15: Show Remarks
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III. Creating A Query
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A. Request Line

The items of information that you wish to retrieve from the database are “requested”. This entails dragging the fields up to the Request Line and dropping them there. They may be placed in any order and their order may be changed at any time by dragging and dropping. We will be creating a query that will return all non-salaried transactions for a specified fiscal period. 

· From the Projects table drag Project Num to the Request line.
· From the Tasks table drag Task Num to the Request Line.
· From the Awards table drag Award Num to the Request Line.

· From the Expenditure Types table drag Expenditure Typ Cd to the Request Line.

· From the PTAEO Organizations table drag Organization Unit Cd to the Request Line.

· From the Accounting Transactions table drag Authorizer Info, Distribution Credit Amt, Distribution Debit Amt, Invoice Num, Je Line Attributes 4 and 5, Orig Trans Batch Nm, Trans Dsc, Trans Source and Transaction Dt to the Request Line.

· From the Vendors table drag Vendor Nm to the Request Line.

· Change the field names Distribution Debit and Credit Amts to Debit Amount and Credit Amount by double clicking on the name in the Request Line. The item properties box will open and you can alter the name in the Name: box. 
B. Limit Line

Limits refine your data set by excluding data you don’t need. When applying a limit, you supply (or select from a list) data values associated with a data item, and use mathematical logic to apply the values as constraints. All limits are applied through the Limit dialog box. To initiate a limit on a field either double click the field or click and drag it to the Limit Line.

· To establish a limit on a field double click on the field in the table. There are four parts to the dialog box that appears. Double click on Fiscal Period in the Accounting Transactions table.

Figure 16:  Limit Box
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The field name is automatically inserted into this box.

2. This box displays the operator.  If you click on the down arrow on the right of the box you will view the list of operators (see Appendix A). When you are limiting to one value Equals is the appropriate operator. If you were limiting 2 or more periods you would use either Equals or Between depending on whether the periods were contiguous or not.
3. This is where you type in the value of the limit you are setting. A comma with no spaces separates more than one value.
4. To the left of this window are two buttons that are important. As you can see, Custom Values is selected. These are values you input. This box will reflect all values you have ever entered unless you remove them. After using the query many times you will generate a list from which you can choose a value instead of typing it in every time. 
5. Show Values causes Brio to survey the database and return all the possible values for that field. For this reason, you must never click on Show Values in the Query section when you are accessing the Data Warehouse. Your query will run endlessly and you will need to use the Task Manager to abort the application. Show values is often useful when setting limits in the Results section.
6. Certain Limits should be set to increase query processing efficiency. Setting Organizational Limits for financial queries fills that role. Create a Limit for Division Cd, which you will find in the PTAEO Organization table. The operator is =Equal and all Division codes begin with a capital D followed by 5 numbers.
7. A second Limit that increases efficiency is the Department Nm found in the PTAEO Organization table. This time we want the operator to be Begins With. Then we can just use the departmental prefix, which must be typed all in capitals. This will avoid having to type in the whole department name.
8. Master Parent Account Cd – Open the Object Codes table. We only want to view non-salaried transactions so the Master Parent Account Cd must be set to MS8000.

9. Save your file and click on the Process button in the standard toolbar.
Please Note: Refer to Getting Started with Brio Intelligence 6.6 for a discussion of compound limits, variable limits and customizing limits, pages 7-9 through 7-11.

IV. The Results Section (Figure 17)
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Legend:

1 Select All corner

7      Catalog pane

2 Column heading

8,9   Request columns

3 Limit line


10    Cell

4 Sort line


11    Row

5 Row heading

12    Column title

6 Section Pane

A. Troubleshooting:

· “0 of 0 Rows”. When you get this result, 90% of the time, the problem is in setting the limits. Always go back to the Query tab and check each limit. The problem may be in not formatting the field to match the data or in requesting data that doesn’t exist in the field. BrioQuery is case sensitive. You will get “0 of 0 Rows” if you use the wrong case in any field. You can always check on the formatting or content of any field by right clicking on the workspace, selecting Detail View and examining the content of the fields.
D. To get rid of too many rows (Data that you don’t need or want). Re-examine the limits to be sure you’ve restricted the query enough.  In most cases there needs to be an additional limit added.

· At times you may get a particular error message when you ask BrioQuery to process. It can also happen when you request a Detail View. The message says that the Table or View does not exist. The new Data Warehouse is still under development so modifications are made from time to time. If you should receive this message complete the following procedure:

Figure 18: Sync w/ Database
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Go to the DataModel menu and select Sync with Database. The process will take about 10 seconds. (Figure 13)

2. A Data Model Synchronization Box will appear and inform you that your data model has been synchronized with the database and will list the changes that have been made. (Figure 14)

3. Click on OK. Your query should now process.

4. You may also get this error message if you have not placed a limit on Fiscal Period.

Figure 19: Synchronization Message
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Please Note:   At this point you would run a Web Fixed Format Report and verify that the total that you extracted in Brio ties out to the report. In this case you would run the Position Plan Report.

B. Sorting Data
· Simple Sort

There are two ways to perform a simple sort. Highlight the column you wish to sort and click on the ascending or descending Sort icon on the Standard toolbar. You will then see the column name on the Sort line. Even simpler, double click on the column name in the workspace.

E. Multiple Sort

Drag items to the Sort line in the order you wish the sort to progress. When you sort more than one data item at a time, the left to right order of data on the Sort line dictates the sort order and creates a nested effect. The leftmost item on the Sort line is the primary sort. Items to the right are sorted in progression, each within the categories of the preceding item. 

The Sort line can be moved, sized, docked and hidden. To toggle the Sort line, click the Sort button on the Section title bar.

C. Export to Excel

· From the Menu Bar, click on File>Export/Section. The default file type is for Excel.
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Figure 20: Export to Excel
· In the dialog box that appears choose the directory where you want the file and a useful name. It is recommended that you maintain the same name as the query so that you know where the Excel file came from. Add a date to indicate when you exported the results of the query.

D. Creating a Counter

If you need to be able to do counts of various parameters you can create a counter by adding a computed column in the Results section that consists solely of 1’s. This column can then be added to report sections and tallied up as a counter for label items. 

Figure 21: Counter
· [image: image34.png]Function Categories:

Functions:

Conienalcions
D Fangts

Numeic Funciions ek
ting F.
ystem Funclons
Extiacts a substing fiom the cheracter expression
From Column o expression
2 Oria_Trans_Bach Nm Reference

Stating posiion

Number of chars o extract
£l




Right click on the workspace and select Add Computed Item.
· Change the name from Computed to Counter.

· Type a “1” in the Definition box.

· Click on OK.

· A “1” will be placed in every row.

E. Local Limits

There are times when you only want to see part of the data you retrieve. For example, suppose you only wish to see a particular org or one expenditure type. This can be done effectively by setting limits in Results.

To set a Local Limit, drag the relevant report column from the workspace or the catalog pane to the Limit Line. Another method is to double click on the gray bar above the column title. For practice, double click on the gray bar above Organization Unit Cd. A Limit box opens. Click on Show Values and select an Award Number. As you can see, now Show Values behaves just like filters in Excel. To get all your rows back just double click on Organization Unit Cd in the Limit Line and click on the Ignore button. This will de-activate the limit and allow it to remain on the Limit Line for use in the future.

V. Tables
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A table is a columnar arrangement of data. In BrioQuery, tables are used as building blocks in other reporting sections. Table sections function in much the same way as the Results section. All of the commands that are available on the Results menu are also available on the Table menu.

The data in a Table section is derived from the section that is active when you choose to insert a new table. When you insert a Table section from the Results section, the new Table Section is attached to the Results section. This means any changes to the results set are immediately propagated to the Table section. You can also create additional tables, pivot tables, charts, and other reports form a Table section’s dataset just as you would from the Results section. Limits, computed columns, grouping columns, and other actions that modify the active section’s data set carry over to all tables and reporting sections built from that section.


Figure 22: The Table Section
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Creating a Table

Use the Table Outliner to construct, plot, and manage data. To create a table based on the Results section data:

1. From the Results section, choose Insert→New Table. If the Table Outliner is not already displayed, click Outliner on the Section title bar.

2. Drag Results items from the Catalog pane to the Table Outliner. BrioQuery automatically populates the table columns.

B. Tables as a Data Staging Area

Computed items in the Results section become mere data elements when added to a Table section. Thus, the Table section can become an intermediate calculation staging area. This ability comes in handy in applications where you wish to place limits on computed items. 

For example, suppose you wanted a report of the top 10 expenditures in your organization (division or department). It is easy to add a computed item to your Results section that is based on the Rank function. (This function lets you find out each expenditure’s rank relative to the others.) However, when you try to limit the results based on that ranking, BrioQuery informs you that limits cannot be placed on aggregate items.

To get the results you want, you need to insert a new Table section that is based on your Results section. Then add all the relevant Results items, including the computed Rank field. Once Rank is a column in the table, it is no longer a computed item. It is a regular number on which you can now place a limit. Since the Table section is based on the Results section, your Top 10 report will automatically be updated each time you run the query.

Limits set in the Table section are automatically propagated to any other reports that inherit their data set from the table. You can apply only one limit per column.

C. Computed Items, Grouping and Data Functions
As you become more comfortable with BrioQuery you should learn to do the following in both the Results and Table sections:

· Create Computed Items

· Add Grouping Columns

· Add Date Groups

· Apply Data Functions

· Adding Grand totals and Break Totals.

Instructions may be found in Appendix A, in the Data Analysis and Reporting with BrioQuery 6.5 documentation, pages 2-6 to 2-12, and in Getting Started with Brio Intelligence 6.6, section 8, Computed Items.

Pivot Reports (Figure 23)
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Pivot tables are interactive tools used to slice and dice data for ad-hoc, interactive and multidimensional analysis.

Pivot tables are made up of:

· Facts – Core numeric data that you can look at in different ways.
· Dimensions – Descriptive items that break aggregate data (facts) into logical categories. In the Pivot section, dimensions are either Top Labels or Side Labels.
In the Pivot we will create here, we will show the relevant information for purchase transactions. 

A. Creating a Pivot Table
1. On the menu bar select Insert/New Pivot.

2. If the Outliner is not visible (see 5 & 6 in Figure 23) click Outliner on the Section title bar.

3. Select Fiscal Period Description from the Catalog pane and drag it to the Top Label pane in the Outliner. Another method of adding fields to the Pivot Report is to right click on it in the catalog pane and select where to place it in the Outliner.

4. Select Vendor Nm, Transaction Date, PTAEO, Invoice Num and Transaction Dsc from the Catalog pane and drag them to the Side Label pane in the Outliner. Items are hierarchically ordered in the sequence in which they appear in the Outliner panes. You can click and drag to change the order.

5. Select Debit Amount and Credit Amount from the Catalog Pane and drag it to the Facts pane in the Outliner.

B. Formatting a Pivot Table
Column Widths:

· Move your pointer to the right boundary of the column you wish to change in the report.

· While pointing to the line a double-sided arrow will appear. Drag to the left or right to make the column the proper width for the data it contains. Excel uses the same technique, including double-clicking the right boundary to perform an automatic fit.

Column headers for the Side Labels:

BrioQuery calls these Corner labels. Right click on the workspace and select Corner labels. You can choose Side, Top or Both. If you select Both you will get a label for the Source as well as headers for the side labels. Select Side.

Column names are too wide for the data in the column:

If the row height is increased the column header will automatically word wrap. On the row whose height you wish to increase, put your cursor on the bottom border where it becomes a double arrow (see below). Click and drag to desired size.

Figure 24: Row Height
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Changing Column Header Names
Think about what you would like the column names to be before you process the query. Then you can make the changes in the Query section, which will populate down to the reports. Most of the time the original field name will do.

If you decide later that you want a name change, just go to the Query section, change the name and process the report. BrioQuery is a flexible tool.

Add Totals
· To add totals across, click on the Dimension tab to the right of the top row. Click on the Σ in the standard toolbar. Because we are displaying one month and have two columns in the fact pane, this is not feasible in this query.
· To add totals down, highlight the leftmost column and click on the Σ in the standard toolbar.
· To subtotal by Vendor, highlight the next column over and click on the ( again.
Sorting Pivot Tables
· If the Sort line is not visible, click Sort on the Section title bar.

· In the Sort list, select the item that you want to use as the basis of your sort. Select Vendor Name.

· In the By drop-down list, click the sort type (either a label or a value). Leave the selection as value.

· By default, BrioQuery sorts data in ascending order. To sort in descending order, click the descending icon.

Changing the Background Color:

The Pivot Reports do not print well because of the gray background color in the top and side labels. This can be changed to white, a much lighter gray or any other color you might like. See Appendix B for instructions on changing the default background color.

· Highlight all the gray areas using the CTRL-click technique.

· Click on the drop down list for Fill Color in the formatting toolbar. Select the color you wish to appear in the background. 

Figure 25: Formatting Color
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Focus on Item(s)

In BrioQuery 5.6 we taught the Focus on Item(s) feature to limit transaction sources. This is not the best practice because there is the possibility of inaccuracies. This kind of limit on data should be established by using Brio 6’s Table feature.

C. Other Data Functions
There are other ways to look at the data besides showing the amounts. Let’s create a second simple Pivot and look at some possibilities.

1. Insert a new Pivot. Name it Exp Data.

2. Add a computed column and concatenate Expenditure Typ Cd and Expenditure Typ Nm. Name the column Expenditure Type. Add a computed column that represents the Net Amount.  (See Appendix A, page 28)

3. Insert Expenditure Type in the Side Labels section of the Outliner. Put Fiscal Period Description in the Top Labels section.

4. In the Facts section insert Net Amount and the Counter you created earlier.

5. Format the table by bolding the headings, changing the background color and adding corner labels. Change the name of the Counter column to No of Trans, which is what the counter represents in this report.

6. You can bring amounts into the Facts section of the Outliner multiple times. Put Net Amount into the Facts section and drag it before the Counter. 

7. Right click and select Data Functions. You can change the column to a percentage of the total or an average. Select Average and you will get the average invoice amount per expenditure type. Try out other functions.

8. Figure 26 shows a sample of a completed report.

Figure 26: Pivot Report with Data Functions


V. The Report Function


The Report Designer in the Report section helps you to easily develop a complete range of reports. After you create your database query, you can use this section’s visual layout capabilities to drag and drop columns, expressions, pivot tables, logos, bitmaps and other objects to quickly design and customize your reports.

Figure 27: Report Section Elements

A. Report Section Elements

The Report section differs slightly from other BrioQuery sections in order to provide you with as robust a report designer as possible. Key differences include:

· Expression Line – Accessed via the Expression button on the Section title bar, the Expression line enables you to build common computed expressions using JavaScript.

· Catalog Pane – Contains all of the of drag-and-drop elements you use to create a custom report, including:

· Query – Contains all the sections associated with a selected query, including Results, Pivot, and Chart sections. You can drag individual Results columns from the Results and Table sections to a report page, as well as entire Pivot and Chart sections to create Smart Reports.

· Graphics – Contains standard vector graphics text labels, and pictures (bitmaps only).
· Fields – Contains predefined fields that can be dragged to various areas of the report to enhance the look and feel of the report.

To use any of these elements, simply drag them to the desired report component band.

· Outliner – Consists of the Groups Outliner and Table Outliner. The Table Outliner is divided into the Dimension and Fact panes.

· Groups Outliner – Defines the overall or highest levels used to group data in a report. When you designate an item to serve as a group header (also known as a break value), you are instructing BrioQuery to organize the rest of the data in repeating collections of records according to the group header.

· Dimensions Pane in Table Outliner – Includes the descriptive information as a column in a table that is included in the body of the report.

· Facts Pane in Table Outliner – Includes the measurable or quantifiable data as a column in a table included in the body of the report. BrioQuery automatically calculates and inserts subtotals for each fact column.
B. Creating A Report
1. Go to the Insert menu and select New Report. BrioQuery creates a new Report section above all the other sections and inserts a blank table in the Body band of the report in the Content pane.

2. Select Report/Section Boundaries to view the bands for the report components.

3. Drag Results items from the Query Section of the Catalog pane to the Table Outliner panes.

Please refer to the Data Analysis and Reporting with BrioQuery 6.5, pages 5-1 to 5-27 for complete instructions on creating a Report.

APPENDIX A: Beyond the Basics


A. Concatenation
There are times when it is prudent to join fields together. A prime example is the PTAEO. Rather than 5 separate fields you can have one field containing the 5 segments. The process of joining fields is called concatenation. If you know Java Script this can be done in the report section. However, it can be done in a simple fashion in the Query section. 

1. Right click on the Request Line and select Add Computed Item. Change the default name to PTAEO. Click on the Options button and change the datatype to String.

2. The Definition box is exactly what its name implies. We define exactly what we want in this column. Start by entering the name of the first field by clicking on the Reference button.  The window in figure A-1 appears. Select the column you wish to be first by selecting the appropriate table in the left pane and the field name in the right pane. In the case of forming a PTAEO that would be Project Num.

Figure A-1: The Reference Button



Figure A-2: Concatenation


3. The join begins with two pipes (the key above the enter key |). Then you must decide what you wish to join with (space, period, comma, etc.). Whatever you choose must be between single quotes followed by two more pipes.
4. You now follow with the next field to be joined. Back to the Reference button. This process is repeated until you have the result you want. Figure A-2 shows a completed concatenation for PTAEO.
B. Add a Computed Column
There are many occasions when you require a data structure that is the result of a computation but is not provided in any table. Rather than add a column that computes at the database level it is usually preferable to add one in the Results or Table sections. A perfect example of this is the computation of Net Amount. The Data Warehouse only provides Debit and Credit amounts. Create a Net Amount by completing the steps below:

1. In the Results section right click in the workspace and select Add a Computed Item.

2. A Computed Item box appears. We want to take the debit amount and subtract the credit amount. There is one problem. These columns contain blanks and we must correct for that by using the Null Value function. Click on the Functions button.

3. Null Value is a conditional function, the first item in the left pane. Select Nvl in the right pane.

4. Use the Reference button as always to select the field name, Distribution Debit Amount.

5. In the box you see the message “Returns Expr2 if Expr1 is Null and Expr1 otherwise”. This means that if there’s a blank in the field you have specified in the first box then it will insert whatever you have specified in the second box. So in the second box put a 0.

6. Click on OK and then insert a minus after the ending parenthesis in the Definition box.

7. Repeat the null value procedure for Distribution Credit Amount. Click on OK twice and you should have a correctly computed Net Amount column all the way to the right. A completed definition is shown in figure A-3.

Figure A-3: A Computed Net Amount column


C. Substrings
In the Results section look at the Orig Trans Batch Name field. Make the column wide enough so that you can see the whole entry. After the first 30 characters the information is not helpful. For reporting purposes, it would be better to end the data at the 30th character. We can do this using the substring function.

1. Make sure you are logged on. In the Query section double click on the Orig Trans Batch Nm field on the Request Line. The modify properties box will appear.
2. Click on the Functions… Button. It will not be active unless you are logged on. Select String Functions in the Function List categories: window on the left. Scroll to Substr in the Functions: window on the right.
3. A box appears which assists you in creating the substring (See Figure A-4). Use the Reference… button and find the Orig Trans Batch field from the a table. We want to separate out the first 30 characters so put a 1 in the Starting position box. Then put 30 in the box labeled Number of chars to extract. Click on OK and you will see the completed box in Figure A-5.
Figure A-4: Completed Function box for Substring

Figure A-5: Completed Item Properties Box

APPENDIX B: Limit Operators and Values


The following logical operators are supplied for defining limits, and support standard SQL wildcards including "%" and "_".  

Equal

( = )
Retrieves only records where the limited item equals the specified value(s)

Not Equal

( <> )

Retrieves only records where the limited item does not equal the specified value(s).

Less Than
( < )
Retrieves only records where the limited item is less than the specified value(s).

Less or

Equal ( <= )
Retrieves only records where the limited item equals, or is less than the specified value(s).
Greater 

Than ( > )
Retrieves only records where the limited item is greater than the specified value(s).
Greater or

Equal ( >= )
Retrieves only records where the limited item equals, or is greater than the specified value(s).
Begins 

With
Retrieves only records where the limited item begins with the specified value(s) up to and including the end value.

Contains
Retrieves only records where the limited item contains the specified value(s) regardless of location.

Ends With
Retrieves only records where the limited item ends with the specified value(s).
Like (with

wildcards)
Retrieves records where a text string appears and reflects the placement of the specified value(s); for example., Name Like %ZE_ would retrieve records for all employees whose names contain the letters Ze followed by a single character at the end.

Is Null
Retrieves only records where the limited item has no value; for example a field in which no data has been entered.
Between
Retrieves only records where the value of the limited item lies between (and does not equal) the specified values.
Not (with 

operator)
Negates the operator it precedes, reversing the results of the equation.

Tip: Text strings are evaluated differently among database systems, and are often case-sensitive (that is, "RED", "Red" and "red" may not be equivalent in comparison). Text characters are generally valued in ascending order (0 1 ... 9 A B C ... Z a b c ... z), so that "A" is less than "a" in string comparisons, and strings beginning with numbers are considered "less" than strings beginning with alphabetic characters. 
APPENDIX C: Application Preferences


Set Default Formats

Users can minimize formatting tasks by setting default format preferences for each section Brio. Number formats can be set as well.

To set default format preferences:

1. On the Tools menu, point to Options, and then click Default Formats.

2. In the Default Fonts and Styles dialog box, click a report section tab or the Numbers tab.

3. Select the preferred formatting option, and then click the OK button.

Please Note: Some recommended changes are included below. Other than those changes, it is recommended that you leave the defaults until you are more familiar with the program. The OLAP and Chart tabs are not discussed because those functions are not currently taught.

The Query Tab


It is recommended that you leave the defaults until you have experience with the query section. If you make changes and decide you don’t like them  just select the Defaults button and it will reset all the changes you have made for that tab.

The Table tab


A table looks just like a spreadsheet. In addition to the font style and size you can change the color of the text and background of the Headings (column headers) and the rows of data.

The Pivot tab

The Pivot report is also like a spreadsheet but includes the ability to “pivot”. Pivoting is the ability to change a label from a top to side (or a side to a top) orientation with a simple click and swing of the label’s tab.


You can change settings for data values (things you can calculate) and labels. Labels are rows above the data and columns to the left of the data. The default background color for labels, light gray may still be too dark for your purposes. The color you choose is shown is the Sample window. There are also several border styles for you to choose from. Whatever you choose from the drop down Borders: list will also be illustrated in the Sample window.

The Report Tab

The Report section gives users the ability to create free-form report styles. Reports can consist of elements such as tables, report group headers, graphics, and pivot reports. It is important to consider font style, font size and attributes such as bold, italic for different elements of the report structure.  For instance, the default for Report table headings is not bold. If you like headings centered then this would be the place to make that the default.


The Numbers Tab

Exercise caution here in what you change. The Date setting is a matter of personal preference. The recommended format is mm/dd/yy. The Timestamp setting should be the same as the Date setting to eliminate the time. The Timestamp is meaningless in the Data Warehouse. The Time setting is something you really won’t use but it probably makes sense to eliminate the seconds. Do not change the Month, Null, Real and Integer settings unless you know the result. You can try different things if you note the original settings. Then, if necessary, you can change them back. Notice that there is no default button on the Numbers tab.


Set Default Program Options

Specific program options can be defined by a user in Brioquery. There are two tabs, General and File Locations where you can specify your preferences.

General Tab

On the Tools menu, select Options, and then Program Options. Make sure the General tab is selected.

Autologon
Auto Logon maintains an existing connection whenever you create a new document. If you are currently logged on, BrioQuery will prompt you to use the current connection. There is no reason to disable this option.

Compress Document

The only setting that you should change without technical help is in Document Save. If you check Compress all documents, this feature will condense the number of bytes in a document in a compressed file format. This will enable you to transmit the document more easily and saves valuable storage space. The decompression of the compressed file happens automatically when you retrieve and reopen the document.

If you only want to compress large documents then you may select this option on an individual basis by following the step below:

· On the File menu, select Save Options, then select Compress Document.
A check mark is displayed next to the Compress Document feature.


Document Scheduling 

This option is not applicable as it refers to an option available only when your documents are stored in a Repository.

Date Handling

Do not change this setting unless directed to by a technician. The default here, when you enter only two digits for the year, Brio handles the dates as follows:

Two digit years entered from 00, up to and including29, are assigned to the 21st century (2000 to 2029) For example, if you enter 7/31/00, Brio accepts the date as July, 31 2000.

Two digit years entered from 30 up to and including 99 are assigned to the 20th century (1930 to 1999. For example, if you enter 7/31/89, Brio accepts the date as July 31, 1989.

Since Brio users at Yale do not enter data, it is only important to know how Brio handles dates in the database. There is no data in any of the Oracle databases that has dates early in the 20th century so this scheme presents no problems.

File Locations Tab

Document Directory

In this new version of BrioQuery we can now specify where we want our queries saved. Use the Browse…  button to locate the folder where you store your queries. Click on Ok set the location.

Connections Directory

This window should already be set to c:\brio\opencat. This is where all your OCE files reside. If the window is blank use the Browse button again to locate the folder and click on OK.

Default Connection:

This setting is optional. It stipulates which connection file (OCE) to use when none is specified, such as when you click the connection icon in a new document file. You would want this to be blank if you use more than one database with BrioQuery.

Preferred Repository Connection and HTML Template Directory:

The last two settings are not applicable, as Yale does not use these functions.







Defaults to Excel File





Recommend using same name as the query











Select the folder where you want to save the file
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